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Word 2007 Mail Merge
Overview
You use mail merge when you want to create a set of documents, such as a form letter that is sent to
many customers. Each letter has the same kind of information, yet the content is unique. For example,
in letters to your customers, each letter can be personalized to address each customer by name. The
unique information in each letter comes from entries in a data source.

Steps to Mail Merge
1. Set up the main document: The main document contains the text and graphics that are the
same for each version of the merged document — for example, the return address or salutation
in a form letter.
2. Connect the document to a data source: A data source is a file that contains the information to
be merged into a document. For example, the names and addresses of the recipients of a letter.
3. Refine the list of recipients or items: Word generates a copy of the main document for each
item, or record, in your data file. If your data file is a mailing list, these items are probably
recipients of your mailing. If you want to generate copies for only certain items in your data file,
you can choose which items (records) to include.
4. Add placeholders, called mail merge fields, to the document: When you perform the mail
merge, the mail merge fields are filled with information from your data file.
5. Preview and complete the merge: You can preview each copy of the document before you
print the whole set.
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Use mail merge to create:
A catalog or directory: The same kind of information, such as name and description, is
shown for each item, but the name and description in each item is unique.
A set of envelopes: The return address is the same on all the envelopes, but the
destination address is unique on each one.
A set of mailing labels: Each label shows a person's name and address, but the name
and address on each label is unique.
A set of e-mail messages: The basic content is the same in all the messages, but each
message goes to the individual recipient and each message contains information that is
specific to that recipient, such as the recipient's name or some other piece of
information.

Set up the main document
1. Start Word. A blank document opens by default. Leave it open. If you close it, the commands in
the next step are not available.
2. On the Mailings tab, in the Start Mail Merge group, click
Start Mail Merge.
3. Select either Letters, email, envelopes, and labels

Connect to a data source
To merge information into your main document, you must connect the document to a data source, or a
data file. If you don't already have a data file, you can create one during the mail merge process.

Choose a data file
1. On the Mailings tab, in the Start Mail Merge group, click
Select Recipients.
2. Do one of the following:
Use Outlook Contacts: If you want to use your
Contacts list in Outlook, click Select from Outlook
Contacts.
Use an existing data source file: If you have a Microsoft Office Excel worksheet, a Microsoft
Office Access database, or another type of data file, click Use Existing List, and then locate
the file in the Select Data Source dialog box.
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For Excel, you can select data from any worksheet or named range within a workbook. For
Access, you can select data from any table or query that is defined in the database.

For another type of data file, select the file in the Select Data Source dialog box. If the file is not
listed, select the appropriate file type or select All Files in the Files of type box.
Types of data files:
Files from single-tier, file-based database programs for which you have installed an OLE DB
provider or ODBC driver (a number of which are included with Microsoft Office).
An HTML file that has a single table. The first row of the table must contain column names, and
the other rows must contain data.
Electronic address books: Microsoft Outlook Address Book , Microsoft Schedule+ 7.0 Contact
List
Any similar address lists that were created with a MAPI-compatible messaging system, such as Microsoft
Outlook.
A Microsoft Word document. The document should contain a single table. The first row of the
table must contain headings, and the other rows must contain the records that you want to
merge. You can also use a header source as a data source.
Any text file that has data fields separated (or delimited) by tab characters or commas and data
records separated by paragraph marks.

Type a new list
1. In the New Address List dialog box, type the information for the first address, or record, that
you want to include in your label merge.
2. After you type all the information for your first record, click New Entry, and then type the
information for the next record. Continue until you have typed information for all the records
that you want to include.
3. When your new list is complete, click OK.
4. In the Save Address List dialog box, type a name for your new list, and then click Save.
Tips for formatting data in Excel
If your data file is an Excel worksheet that includes percentages, currency values, or postal codes, you
can preserve the numeric formatting of the data by using Dynamic Data Exchange to connect to the
Excel worksheet from Word. For example, you can make sure a five-digit postal code of 07865 from your
data file is not displayed as the number 7865 (without the leading zero).
Before you connect to the worksheet, do the following in Word:
1. Click the Office Button
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2.
3.
4.
5.

Click Advanced.
Scroll to the General section, and select the Confirm file format conversion on open check box.
Click OK.
With the mail merge main document open, in the Start Mail Merge group of the Mailings tab,
click Select Recipients, and then click Use Existing List.
6. Locate the Excel worksheet in the Select Data Source dialog box, and double-click it.
7. In the Confirm Data Source dialog box, click MS Excel Worksheets via DDE (*.xls), and then click
OK.
8. In the Microsoft Office Excel dialog box, for Named or cell range, select the cell range or
worksheet that contains the information that you want to merge, and then click OK.
Refine the list of recipients or items
When you connect to a certain data file, you might not want to merge information from all the records
in that data file into your main document.
To narrow the list of recipients or use a subset of the items in your data file, do the following:
1. On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List.
2. In the Mail Merge Recipients dialog box, do any of the
following:
3. Select individual records: This method is most useful if
your list is short. Select the check boxes next to the
recipients you want to include, and clear the check
boxes next to the recipients you want to exclude.
4. Sort records: Click the column heading of the item that you want to sort by. The list sorts in
ascending alphabetical order (from A to Z). Click the column heading again to sort the list in
descending alphabetical order (Z to A).
5. Filter records: This is useful if the list contains records that you know you don't want to see or
include in the merge. After you filter the list, you can use the check boxes to include and exclude
records.
6. Add mail merge fields
After you connect your main document to a data file, you are ready to type the text of the document
and add placeholders that indicate where the unique information will appear in each copy of the
document.
The placeholders, such as address and greeting, are called mail merge fields. Fields in Word correspond
to the column headings in the data file that you select.
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Columns in a data file represent categories of information. Fields that you add to the main document
are placeholders for these categories.
Rows in a data file represent records of information. Word generates a copy of the main document
for each record when you perform a mail merge.
By putting a field in your main document, you indicate that you want a certain category of
information, such as name or address, to appear in that location.
When you insert a mail merge field into the main document, the field name is always
surrounded by chevrons (« »). These chevrons do not show up in the merged documents.
They just help you distinguish the fields in the main document from the regular text.

What happens when you merge
When you merge, information from the first row in
the data file replaces the fields in your main
document to create the first merged document.
Information from the second row in the data file
replaces the fields to create the second merged
document, and so on.

Working with fields: Examples
You can add any column heading from your data file
to the main document as a field. This gives you
flexibility when you design form letters, labels, e-mail messages, and other merged documents.
You can combine fields and separate them by punctuation marks. For example, to create an address,
you can set up the fields in your main document like this:
«First Name» «Last Name»
«Street Address»
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«City», «State» «Postal code»
For things that you use frequently, like address
blocks and greeting lines, Word provides composite
fields that group a number of fields together. For
example:
The Address Block field is a combination of
several fields, including first name, last
name, street address, city, and postal code.
The Greeting Line field can include one or
more name fields, depending on your
chosen salutation.
You can customize the content in each of these
composite fields. For example, in the address, you
may want to select a formal name format (Mr. Joshua Randall Jr.); in the greeting, you may want to use
"To" instead of "Dear."

Map mail merge fields to your data file
To make sure that Word can find a column in your data file that corresponds to every address or
greeting element, you may need to map the mail merge fields in Word to the columns in your data file.
To map the fields, click Match Fields in the Write & Insert Fields group of the Mailings tab.

The Match Fields dialog box opens.

The elements of an address and greeting are listed on the left. Column headings from your data file are
listed on the right.
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Word searches for the column that matches each element. In the illustration, Word automatically
matched the data file's Surname column to Last Name. But Word was unable to match other elements.
From this data file, for example, Word can't match First Name.
In the list on the right, you can select the column from your data file that matches the element on the
left. In the illustration, the Name column now matches First Name. It's okay that Courtesy Title, Unique
Identifier, and Middle Name aren't matched. Your mail merge document doesn't need to use every
field. If you add a field that does not contain data from your data file, it will appear in the merged
document as an empty placeholder — usually a blank line or a hidden field.

Add the placeholders or fields
1. In the main document, type any content that you want to appear on every copy of the
document.
 To add a picture, such as a logo, click Picture in the Illustrations group on the Home tab.
2. Click where you want to insert the field.
3. Use the Write & Insert Fields group on the Mailings tab.
4. Add any of the following:
a. Click Address block.
b. In the Insert Address Block dialog box, select the address elements that you want to include
and the formats that you want, and then click OK.
c. If the Match Fields dialog box appears, Word may have been unable to find some of the
information that it needs for the address block. Click the arrow next to (not matched), and
then select the field from your data source that corresponds to the field that is required for
the mail merge.
d. Click Greeting line.
e. Select the greeting line format, which includes the salutation, name format, and following
punctuation.
f. Select the text that you want to appear in cases where Microsoft Word can't interpret the
recipient's name, for example, when the data source contains no first or last name for a
recipient, but only a company name.
g. Click OK.
h. If the Match Fields dialog box appears, Word may have been unable to find some of the
information that it needs for the greeting line. Click the arrow next to (not matched), and
then select the field from your data source that corresponds to the field that is required for
the mail merge.
5. On the Mailings tab, in the Write & Insert Fields group, click Insert Merge Field.
6. In the Insert Merge Field dialog box, do one of the following:
a. To select address fields that will automatically correspond to fields in your data source, even
if the data source's fields don't have the same name as your fields, click Address Fields.
b. To select fields that always take data directly from a column in your data file, click Database
Fields.
7. In the Fields box, click the field you want.
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8. Click Insert, and then click Close.
9. If the Match Fields dialog box appears, Microsoft Word may have been unable to find some of
the information it needs to insert the field. Click the arrow next to (not matched), and then
select the field from your data source that corresponds to the field that is required for the mail
merge.
13. In Outlook Contacts, on the View menu, point to Current View, and then click Phone List.
14. Right-click a column heading, and then click Field Chooser.
15. In the drop-down list at the top of the Field Chooser dialog box, select User-defined fields in
folder.
16. Drag the field that you to add from the dialog box to the column headings. A little red arrow
helps you place the field in the location that you want.

You can add a new field in the Field Chooser dialog box by clicking New at the bottom.

17. After you add all of your custom fields to the view, close the Field Chooser dialog box.
18. To remove a field that you do not want included in the mail merge, click the field name in the
column heading in Phone List view, and drag it off of the column heading.
20. In Outlook Contacts, select individual contacts by pressing SHIFT and clicking to select a range or
by pressing CTRL and clicking to select individuals. If you want to include all the contacts
currently visible in the view, do not click on any contacts.
21. On the Tools menu, click Mail Merge.
22. If you have selected individual contacts to include in the merge, click Only selected contacts. If
you want to include all the contacts currently visible in the view, click All contacts in current
view.
23. If you have configured the Phone List view so that it displays exactly the fields you want to use in
the merge, click Contact fields in current view. Otherwise, click All contact fields to make all of
the contact fields available in the merge.
24. If you want to generate a new main document for the merge, click New document. Otherwise,
click Existing document, and click Browse to locate the document to use as the main document.
25. If you want to save the contacts and fields that you have selected, so that they can be reused,
select the Permanent file check box, and then click Browse to save the file. The data is saved in
a Word document as comma-delimited data.
26. Select any merge options you want:
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a.
b.
c.
d.
e.
f.
g.

Form Letters: Prepare a batch of letters for a mass mailing.
Mailing Labels: Set up address labels for a mass mailing.
Envelopes: Set up envelopes for a mass mailing.
Catalog: Create a single document that contains a catalog or address list.
New Document: Generate merged documents, which you can edit individually in Word.
Printer: Send merged documents directly to the default printer.
E-mail: Generate merged documents designed to be e-mail messages. When you are
ready to complete the merge in Word, on the Mailings tab in the Finish group, click
Finish & Merge, and then click Send E-mail Messages. The Subject line is filled with the
text you typed in the Mail Merge Contacts dialog box in Outlook.
1. Click OK. When the document opens in Word, on the Mailings tab, in the Write & Insert
Fields group, click the arrow next to Insert Merge Field, and then click the fields that you
want to add the document.
a. If the merge fields appear inside braces, such as { MERGEFIELD City }, then Word is
displaying field codes instead of field results. This doesn't affect the merge, but if you
want to display the results instead, right-click the field code, and then click Toggle Field
Codes on the shortcut menu.

Format the merged data
Database and spreadsheet programs, such as Access and Excel, store the information that you type in
cells as raw data. Formatting that you apply in Access or Excel, such as fonts and colors, isn't stored with
the raw data. When you merge information from a data file into a Word document, you are merging the
raw data without the applied formatting.
Add formatting
1. Select the mail merge field. Make sure that the selection includes the chevrons (« ») that
surround the field.
2. On the Home tab, in the Font group, apply the formatting that you want. Or click the Font
Dialog Box launcher for more options.
To minimize the extra space between lines in the addresses on your labels, you must select
the lines, click the Paragraph Dialog Box launcher on the Home tab, and then type 0 in the
before and after spacing boxes. If you are using the Address Block merge field, select the
whole field, including the chevrons (« »), and then adjust the spacing.

Preview, complete the merge, and print the documents
After you add fields to your main document, you are ready to preview the merge results. When you are
satisfied with the preview, you can complete the merge.
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Preview the merge
You can preview your merged documents and make changes before
you actually complete the merge.
To preview, do any of the following in the Preview Results group of
the Mailings tab:
1. Click Preview Results.
2. Page through each merged document by using the Next Record and Previous Record buttons in
the Preview Results group.
3. Preview a specific document by clicking Find Recipient.
Click Edit Recipient List in the Start Mail Merge group on the
Mailings tab to open the Mail Merge Recipients dialog box,
where you can filter the list or clear recipients if you see
records that you don't want to include.

Complete the merge
You can print the merged documents or modify them individually. You can print or change all or just a
subset of the documents. If you want to print a subset of the documents, you can specify the set by a
range of record numbers. If you want to print pages instead of specifying record numbers, follow the
instructions in the Change individual copies of the document section.
Print merged documents
1. On the Mailings tab, in the Finish group, click Finish & Merge, and then
Print Documents.
2. Choose whether to print the whole set of documents, only the copy that's
currently visible, or a subset of the set, which you specify by record
number.

click

Change individual copies of the document
1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Edit Individual
Documents.
2. Choose whether you want to edit the whole set of documents, only the copy that's currently
visible, or a subset of the set, which you specify by record number. Word saves the copies that
you want to edit to a single file, with a page break between each copy of the document.
3. After you finish editing the new file of labels, you can print the labels by clicking the Office
Button
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Save the main document
Remember that merged documents that you save are separate from the main document. It's a good
idea to save the main document itself if you plan to use it for another mail merge.
When you save the main document, you also save its connection to the data file. The next time that you
open the main document, you are prompted to choose whether you want the information from the data
file to be merged again into the main document.
If you click Yes, the document opens with information from the first record merged in.
If you click No, the connection between the main document and the data file is broken. The
main document becomes a standard Word document. Fields are replaced with the unique
information from the first record.

Resume a mail merge
If you need to stop working on a mail merge, you can save the main document and resume the merge
later. If you were using the Mail Merge task pane, Word returns to your place in the task pane when you
resume the merge.
1. When you're ready to resume the merge, open the document. Word displays a message that
asks you to confirm whether you want to open the document, which will run a SQL command.
2. Because this document is connected to a data source and you want to retrieve the data, click
Yes. If you were opening a document that you did not realize was connected to a data source,
you could click No to prevent potentially malicious access to data.
3. Click the Mailings tab, and resume your work.
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